
2 The Stata user interface

The windows
This chapter introduces the core of Stata(GUI)’s interface: its main windows, its toolbar, its menus,

and its dialogs. This chapter assumes that you are running Stata(GUI). To reduce clutter, we will refer
to the Stata(GUI) as Stata throughout.

The five main windows are the Review, Results, Command, Variables, and Properties windows.
Except for the Command window, each window has its name in its title bar. These five windows are
typically in use the whole time Stata is open. There are other, more specialized windows such as the
Viewer, Data Editor, Variables Manager, Do-file Editor, Graph, and Graph Editor windows—these
are discussed later in this manual.

To open any window or to reveal a window hidden by other windows, select the window from
the Window menu, or select the proper item from the toolbar. You can also use Alt+Tab to cycle
through all open windows (Stata and other) if you want to change windows from the keyboard. Many
of Stata’s windows have functionality that can be accessed by clicking on the right mouse button
(right-clicking) within the window. Right-clicking displays a contextual menu that, depending on the
window, allows you to copy text, set the preferences for the window, or print the contents of the
window. When you copy text or print, we recommend that you always right-click on the window
rather than use the menu bar or toolbar so that you can be sure of where and what you are copying
or printing.
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The toolbar
This is the toolbar:

The toolbar contains buttons that provide quick access to Stata’s more commonly used features.
If you forget what a button does, hold the mouse pointer over the button for a moment, and a tooltip
will appear with a description of that button.

Buttons that include both an icon and an arrow display a menu if you click on the arrow. Here is
an overview of the toolbar buttons and their functions:

Open opens a Stata dataset. Click on the button to open a dataset with the Open
dialog. Click on the arrow to select a dataset from a menu of recently opened datasets.

Save saves the Stata dataset currently in memory to disk.

Print prints the Results window. Clicking on the arrow displays a list of windows.
Select a window name to print its contents.

Log begins a new log or closes, suspends, or resumes the current log. See [GSU] 16 Sav-
ing and printing results by using logs for an explanation of log files.

Viewer opens the Viewer or brings a Viewer to the front of all other windows.
Click on the button to open a new Viewer. See [GSU] 3 Using the Viewer for more
information.

Graph brings a Graph window to the front of all other windows. Click on the button
to bring the Graph window to the front. Click on the arrow to select a Graph window
to bring to the front. See The Graph button in [GSU] 14 Graphing data for more
information.

Do-file Editor opens the Do-file Editor or brings a Do-file Editor to the front of
all other windows. Click on the button to open a new Do-file Editor. Click on the
arrow to select a Do-file Editor to bring to the front. See [GSU] 13 Using the Do-file
Editor—automating Stata for more information.

Data Editor (Edit) opens the Data Editor or brings the Data Editor to the front of
the other Stata windows. See [GSU] 6 Using the Data Editor for more information.

Data Editor (Browse) opens the Data Editor in browse mode. See Browse mode in
[GSU] 6 Using the Data Editor for more information.

Variables Manager opens the Variables Manager. See [GSU] 7 Using the Variables
Manager for more information.

Clear more Condition tells Stata to continue when it has paused in the middle
of long output. See [GSU] 10 Listing data and basic command syntax for more
information.

Break stops the current task in Stata. See [GSU] 10 Listing data and basic command
syntax for more information.

http://www.stata.com/manuals13/gsu16.pdf#gsu16Savingandprintingresultsbyusinglogs
http://www.stata.com/manuals13/gsu16.pdf#gsu16Savingandprintingresultsbyusinglogs
http://www.stata.com/manuals13/gsu3.pdf#gsu3UsingtheViewer
http://www.stata.com/manuals13/gsu14.pdf#gsuTheGraphbutton
http://www.stata.com/manuals13/gsu14.pdf#gsu14Graphingdata
http://www.stata.com/manuals13/gsu13.pdf#gsu13UsingtheDo-fileEditor---automatingStata
http://www.stata.com/manuals13/gsu13.pdf#gsu13UsingtheDo-fileEditor---automatingStata
http://www.stata.com/manuals13/gsu6.pdf#gsu6UsingtheDataEditor
http://www.stata.com/manuals13/gsu6.pdf#gsuBrowsemode
http://www.stata.com/manuals13/gsu6.pdf#gsu6UsingtheDataEditor
http://www.stata.com/manuals13/gsu7.pdf#gsu7UsingtheVariablesManager
http://www.stata.com/manuals13/gsu7.pdf#gsu7UsingtheVariablesManager
http://www.stata.com/manuals13/gsu10.pdf#gsu10Listingdataandbasiccommandsyntax
http://www.stata.com/manuals13/gsu10.pdf#gsu10Listingdataandbasiccommandsyntax
http://www.stata.com/manuals13/gsu10.pdf#gsu10Listingdataandbasiccommandsyntax
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The Command window
Commands are submitted to Stata from the Command window. The Command window supports

basic text editing, copying and pasting, a command history, function-key mapping, and variable-name
completion.

From the Command window, pressing
Page Up steps backward through the command history.

Page Down steps forward through the command history.
Tab auto-completes a partially typed variable name, when possible.

See [U] 10 Keyboard use for more information about keyboard shortcuts for the Command window.

The command history allows you to recall a previously submitted command, edit it if you wish,
and then resubmit it. Commands submitted by Stata’s dialogs are also included in the command
history, so you can recall and submit a command without having to open the dialog again.

The Results window
The Results window contains all the commands and their textual results you have entered during

the Stata session. While you can scroll through the Results window to look at work you have done,
it is much simpler to search within the Results window by using the find bar. By default, the find bar

is hidden. You can toggle its visibility by clicking the magnifying glass button, , in the Results
window titlebar.

You can clear out the Results window at any time by right-clicking in the Results window and
selecting Clear Results from the contextual menu. This action is not undoable.

The Review window
The Review window shows the history of commands that have been entered. It displays successful

commands in black and unsuccessful commands, along with their error codes, in red.

The toolbar has two tools for manipulating the contents of the Review window. Clicking on the

magnifying glass button, , in the Review window titlebar toggles the visibility of these tools. Text
entered in the Filter commands here field will filter the commands appearing in the Review window.
By default, the filter will ignore case and find any commands containing any of the words in the filter.
Clicking on the arrow under the magnifying glass will allow you to change this behavior. Clicking

on the hide errors button, , toggles the hiding of commands that ran with an error.

No commands are deleted by using these tools—all that is affected is their visibility.

To enter a command from the Review window, you can
• Click once on a past command to copy it to the Command window, replacing the contents of

the Command window.
• Double-click on a past command to resubmit it. Executing the command adds the command to

the bottom of the Review window.

Right-clicking on the Review window displays a menu from which you can select various actions:
• Cut removes the selected commands from the Review window and places them on the Clipboard.
• Copy copies the selected commands to the Clipboard.
• Delete removes the selected commands from the Review window.
• Select All selects all the commands in the Review window, including those before and after

the commands currently displayed.

http://www.stata.com/manuals13/u10.pdf#u10Keyboarduse
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• Clear All clears out all the commands from the Review window, including those before and
after the commands currently displayed.

• Do Selected submits all the selected commands and adds them to the bottom of the command
history. Stata will attempt to run all the selected commands, even those containing errors, and
will not stop even if a command causes an error.

• Send to Do-file Editor places all the selected commands into a new Do-file Editor window.
• Save All... brings up a Save Review Contents dialog, which allows you to save all the commands

in the Review window, including those before and after the commands currently displayed, in
a do-file. (See [GSU] 13 Using the Do-file Editor—automating Stata for more information on
do-files.)

• Save Selected... brings up a Save Review Contents dialog, which allows you to save the selected
commands in the Review window in a do-file.

• Preferences... allows you to edit the preferences for the Review window.

The Variables window

The Variables window shows the list of variables in the dataset, along with selected properties of
the variables. By default, it shows all the variables and their variable labels.

Click once on a variable in the Variables window to select it. Multiple variables can be selected
in the usual fashion, either by Ctrl -clicking on nonadjacent variables or by clicking on a variable and
shift-clicking on a second variable to select all intervening variables.

Double-clicking on a variable in the Variables window puts the selected variable at the insertion
point in the Command window.

The leftmost column of the Variables window is called the one-click paste column. You can also
send variables to the Command window by hovering the mouse over the one-click paste column of
the Variables window and clicking on the arrow that appears.

The Variables window supports filtering and reordering of variables. Clicking on the magnifying

glass button, , in the Variables window titlebar toggles the visibility of the filter. Text entered in
the Filter variables here field will filter the variables appearing in the Variables window. The filter is
applied to all visible columns and shows all variables that match the criteria in at least one column.
By default, the filter will ignore case and show any variables for which at least one column contains
any of the words in the filter. Clicking on the arrow by the magnifying glass will allow you to change
this behavior as well as add or remove additional columns containing information about the variables.

You can reorder the variables in the Variables window by clicking on any column header. The
first click sorts in ascending order, the second click sorts in descending order, and the third click
puts the variables back in dataset order. Thus clicking on the Variable column header will make the
Variables window display the variables in alphabetical order. Sorting in the Variables window is live,
so if you change a property of a variable when the Variables window is sorted by that property, it will
automatically move the variable to its proper location. Reordering the display order of the variables
in the Variables window does not affect the order of the variables in the dataset itself.

Right-clicking on a variable in the Variables window displays a menu from which you can select
• Keep Only Selected Variables to keep just the selected variables in the dataset in memory.

You will be asked for confirmation. This affects only the dataset in memory, not the dataset as
saved on your disk. See [GSU] 12 Deleting variables and observations for more information.

http://www.stata.com/manuals13/gsu13.pdf#gsu13UsingtheDo-fileEditor---automatingStata
http://www.stata.com/manuals13/gsu12.pdf#gsu12Deletingvariablesandobservations
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• Drop Selected Variables to drop, or eliminate, the selected variables from the dataset in memory.
You will be asked for confirmation. Just as above, this affects only the dataset in memory, not
the dataset as saved on your disk. See [GSU] 12 Deleting variables and observations for more
information.

• Copy Varlist to copy the selected variable names to the clipboard.
• Select All to select all variables in the dataset that satisfy the filter conditions. If no filter has

been specified, all variables will be selected.
• Send Varlist to Command Window to send all selected variables to the Command window.
• Preferences... to change the preferences for the Variables window.

Items from the contextual menu issue standard Stata commands, so working by right-clicking is just
like working directly in the Command window.

If you would like to hide the Variables window, grab the divider between the Variables window
and the Results window and drag it all the way to the right. This is like resizing the Variables window
to have zero width. Hiding the Variables window will also hide the Properties window.

To reveal a hidden Variables window, drag the right edge of the main Stata window to the left.
You can also select Window > Variables to expose a narrow Variables window.

The Properties window

The Properties window displays variable and dataset properties. If a single variable is selected
in the Variables window, its properties are displayed. If there are multiple variables selected in the
Variables window, the Properties window will display properties that are common across all selected
variables.

Clicking the lock icon in the Properties window titlebar toggles the ability to alter properties of
the selected variables. By default, changes are not allowed. Once the properties are unlocked, you
can make any changes to variable or dataset properties you like. Each change you make will create
a command that appears in the Results and Command windows, as well as in any command log, so
the changes are reproducible. Using the Properties window is one of the simplest ways of managing
notes, changing variable and value labels, and changing display formats. See [D] notes, [D] label,
and [D] format.

Clicking the arrow buttons next to the lock icon will select the previous or next variable shown
in the Variables window, and that selection will be reflected in the Properties window.

If you would like to hide the Properties window, click on the disclosure control in the titlebar
of the Variables window. If you would like to reveal a hidden Properties window, click on the

disclosure control in the titlebar of the Variables window.

You should also investigate the Variables Manager, explained in [GSU] 7 Using the Variables
Manager, because it extends these capabilities and provides a good interface for managing variables.

Menus and dialogs

There are two ways by which you can tell Stata what you would like it to do: you can use menus
and dialogs, or you can use the Command window. When you worked through the sample session in
[GSU] 1 Introducing Stata—sample session, you saw that both ways have strengths. We will discuss
the menus and dialogs here.

http://www.stata.com/manuals13/gsu12.pdf#gsu12Deletingvariablesandobservations
http://www.stata.com/manuals13/dnotes.pdf#dnotes
http://www.stata.com/manuals13/dlabel.pdf#dlabel
http://www.stata.com/manuals13/dformat.pdf#dformat
http://www.stata.com/manuals13/gsu7.pdf#gsu7UsingtheVariablesManager
http://www.stata.com/manuals13/gsu7.pdf#gsu7UsingtheVariablesManager
http://www.stata.com/manuals13/gsu1.pdf#gsu1IntroducingStata---samplesession
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Stata’s Data, Graphics, and Statistics menus provide point-and-click access to almost every
command in Stata. As you will learn, Stata is fully programmable, and Stata users can even create
their own dialogs and menus. The User menu provides a place for programmers to add their own
menu items. Initially, it contains only some empty submenus. As an example, suppose you wish
to perform a Poisson regression. You could type Stata’s poisson command, or you could select
Statistics > Count outcomes > Poisson regression, which would display this dialog:

This dialog provides access to all the functionality of Stata’s poisson command. Because the
dependent and independent variables must be numeric, you will find that the combobox will display
only numeric variables for choosing. The poisson command has many options that can be accessed
by clicking on the multiple tabs across the top of the dialog. The first time you use the dialog for a
command, it is a good idea to look at the contents of each tab so that you will know all the dialog’s
capabilities.

The dialogs for many commands have the by/if/in and Weights tabs. These provide access to
Stata’s commands and qualifiers for controlling the estimation sample and dealing with weighted data.
See [U] 11 Language syntax for more information on these features of Stata’s language.

The dialogs for most estimation commands have the Maximization tab for setting the maximization
options (see [R] maximize). For example, you can specify the maximum number of iterations for the
optimizer.

Most dialogs in Stata provide the same six buttons you see at the bottom of the poisson dialog
above.

OK issues a Stata command based on how you have filled out the fields in
the dialog and then closes the dialog.

http://www.stata.com/manuals13/u11.pdf#u11Languagesyntax
http://www.stata.com/manuals13/rmaximize.pdf#rmaximize
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Cancel closes the dialog without doing anything—just as clicking on the
dialog’s close button does.

Submit issues a command just like OK but leaves the dialog on the screen so
that you can make changes and issue another command. This feature is handy
when, for example, you are learning a new command or putting together a
complicated graph.

Help provides access to Stata’s help system. Clicking on this button will
typically take you to the help file for the Stata command associated with the
dialog. Clicking on it here would take you to the poisson help file. The help
file will have tabs above groups of options to show which dialog tab contains
which options.

Reset resets the dialog to its default state. Each time you open a dialog, it
will remember how you last filled it out. If you wish to reset its fields to their
default values at any time, simply click on this button.

Copy Command to Clipboard behaves much like the Submit button, but
rather than issuing a command, it copies the command to the Clipboard. The
command can then be pasted elsewhere (such as in the Do-file Editor).

The command issued by a dialog is submitted just as if you had typed it by hand. You can see
the command in the Results window and in the Review window after it executes. Looking carefully
at the full command will help you learn Stata’s command syntax.

In addition to being able to access the dialogs for Stata commands through Stata’s menus, you
can also invoke them by using two other methods. You may know the name of a Stata command for
which you want to see a dialog, but you might not remember how to navigate to that command in
the menu system. Simply type db commandname to launch the dialog for commandname:� �

. db poisson� �
You will also find access to the dialog for a command in that command’s help file; see [GSU] 4 Getting
help for more details.

As you read this manual, we will present examples of Stata commands. You may type those
examples as presented, but you should also experiment with submitting those commands by using
their dialogs. Use the db command described above to quickly launch the dialog for any command
that you see in this manual.

The working directory
If you look at the screenshot on page ‘main4win’, you will notice the status bar at the base of

the main Stata window that contains the name of the current working directory /home/mydir/data.
This path indicates that /home/mydir/data is the current working directory. The current working
directory is the folder where graphs and datasets will be saved when typing commands such as save
filename. It does not affect the behavior of menu-driven file actions such as File > Save or File
> Open.... Once you have started Stata, you can change the current working directory with the cd
command. See [D] cd for full details. Stata always displays the name of the current working directory
so that it is easy to tell where your graphs and datasets will be saved.

http://www.stata.com/manuals13/gsu4.pdf#gsu4Gettinghelp
http://www.stata.com/manuals13/gsu4.pdf#gsu4Gettinghelp
http://www.stata.com/manuals13/dcd.pdf#dcd

